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GUIDELINES FOR QUESTION WRITING 
 

Check the National Board of Medical Examiners (NBME) web site www.nbme.org/about/itemwriting.asp 
for instructions on effective question writing. 
 
Check the TDAC web page http://abpath.org/index.php/tdac-landing for Question Writing Hints – and a 
PowerPoint presentation by Measurement Research Associates including Goals and Important 
Measurement Considerations for Developing and Reviewing Multiple-Choice Items. 
 
Email Clarita Scioscia at clarita@abpath.org when you have finished entering all of your questions. She 
will edit the questions to put them in ABPath format and then print them for the notebooks. Once you 
have emailed her, do not make any further changes to your questions. 
 
General Guidelines – All Questions 
 

• All questions for all divisions of the examination must be single, multiple-choice best answer. 
• If you are not going to type your questions directly into the item submission website, you must 

copy and paste them from Notepad (not Word) or save as plain text format. 
• Only use well known abbreviations that have been accepted by the TDAC. These lists are 

available on the TDAC web page listed above. Otherwise, place abbreviations in parentheses 
after the spelled-out term; e.g., diethylstilbestrol (DES). Thereafter the abbreviation may be 
used alone. If the term is not used again, omit the abbreviation, unless it is essential to the 
candidate's recognition of the term. 

• Avoid the use of imprecise terms such as may, often, frequently and absolutes such as always 
and never. 

• The ABPath does not use the possessive case with eponymic terms, e.g., Down syndrome. Use 
generic terms instead of eponymic terms whenever possible.  

• Do not use fictitious or obscure terms. 
• Avoid the use of proprietary names. 
• Because reference intervals vary widely, list the reference intervals when units of measure or 

laboratory values are used. Present data in tabular form when it makes a question easier to read. 
• Titers should be expressed as the reciprocal without the 1:, that is, 32, not 1:32. Dilutions and 

ratios, however, are expressed as 1:__. 
• Special characters may be added in the stem or distractors by clicking on the Omega symbol in 

the heading of each stem/distractor entry box, and selecting the special character needed. 
• Do not use the word “pathology” to refer to a specific lesion or pathologic finding. Pathology is 

the study of disease. 
• If you have entered a question that you would like to withdraw, type "DELETE" in the stem box, 

and it will be deleted by the ABPath staff. 
• When questions are edited, finalized, and moved to the permanent item bank by the ABPath 

staff, the answers will automatically be alphabetized. If you do NOT want the answers in 
alphabetical order, for instance a listing of diagnoses that go from benign to malignant, 
“uncheck” the “Alphabetize Distractors” button in the lower right-hand corner of the question 
template. 

 
  

http://www.nbme.org/about/itemwriting.asp
http://abpath.org/index.php/tdac-landing
mailto:clarita@abpath.org
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Question Content 
 

• The content of the question should emphasize: 
• BASIC INFORMATION THAT EACH CANDIDATE WILL NEED TO KNOW ON A DAILY BASIS. 
• Intuitive thinking based on the information in the stem. 
• Information that is clearly appropriate for the level of the examination; i.e., primary, 

subspecialty qualification, or continuing certification. 
• Avoid controversial topics for questions. 
• Do not base questions on one specific article giving one piece of information. Items should be 

able to be answered from more than one source. 
 

Stem 
 

• State a single, clearly formulated problem as a question “What is the most likely diagnosis for 
this (location) biopsy/lesion from a #-year-old male/female?” 

• Place terms or phrases that are common to all distractors in the stem. 
• Short stems with basic information are best, omit unnecessary description, but be sure that the 

stem is a complete thought. 
• Do not place information in the stem that will teach or give a clue to the answer, especially 

grammatical clues. 
• The use of “except” questions and other negative stems is not permitted. 
• All questions should be written in the past tense – “A 23-year-old male/female had . . ."  
• Include age and sex on all patient-based questions. 
• Use male/female - not man/woman, boy/girl. 
• If necessary, refer to race as Black/White/Asian/Hispanic/Native American/country of origin. 
• No stems with personal pronouns, e.g., “You are asked” or “In your lab”. 
• True/false “statement” questions are not permitted, e.g., “Which statement regarding “X” is 

true?” Ideally, you should be able to cover the distractors and answer the question just by 
reading the stem.  With “statement” type stems, there’s no clear question. 

• Omit “of the following” unless necessary, e.g. “Which (of the following) protein function is 
encoded by high-risk HPV genes?” 

 
Distractors 
 

• If possible, they should be approximately the same length and grammatically similar. 
• All must be viable options that should not be able to be narrowed down to two choices. 
• Make sure they are not easily groupable by the candidate, e.g., four benign diagnoses and one 

malignant one (unless the question requires it). 
• “all of the above” or “none of the above” are not permitted as answer choices. 
• Start in lower case, unless the distractor is an independent sentence or begins with a proper 

name. 
• Do not place a period at the end, unless it is necessary for an abbreviation, etc. 

 
General Guidelines - Practical Division of the Examination 
 

• Image and microscopic slide questions may be of the identification type or may be higher order 
questions. Submission of the latter is encouraged. 

• Practical question submissions with visual aids must include the anatomical site and diagnosis 
on the question template. 

• Images must follow HIPAA guidelines for patient confidentiality. 
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General Guidelines - Practical Division of the Examination - continued 

• Carefully and fully identify visual aid materials. List the computer-generated submitter accession 
number from the entered question. This will prevent mix-ups among similar questions and visual 
aids. 

• If needed, label the image with the magnification of photomicrographs, unless the question 
tests for that information. (see page 9) 

• In specially stained preparations, label the image with the stain, unless the question tests for 
that information. (see page 9) 

• Visual aids should illustrate the problem with a minimum of extraneous information. 
• Visual aids must have clear legend information or be explained in the stem of the question. 
• When necessary, indicate the problem illustrated in the visual aid by an arrow or other mark, 

and note it in the stem. (see page 9) 
• Visual aids must contain information needed to answer the question. 
• Visual aids should not be from a study set, e.g., pictures to which some, but not all, of the 

candidates might have access. 
• Visual aids, like questions, must not use copyrighted material. 
• Public domain images (from the internet) may be used, the best being Wikimedia Commons. A 

tutorial to determine if an image is public domain is available on the TDAC web site. 
 

Images 
Accepted images may be used on primary or subspecialty examinations. 

 
• Images are used to illustrate findings that cannot be well demonstrated on a glass slide. 
• Images of a microscopic field should focus on a specific histologic finding. 
• Images must be clear, bright, sharp, and in focus. 
 

Microscopic Slides 
• Microscopic slides should be submitted to the ABPath office before the TDAC meeting in 

sufficient number for each member of the TDAC and the CEO to have a slide for review.  
• The question entry accession number must be written on the frosted end of the slide. Please do 

not affix labels, as the ABPath will use their own labels. 
• The slides should contain the lesion in question, be representative of the lesion, and be 

technically excellent.  
• The balance of slides needed for use on the examination must be available for each question 

that is accepted at the meeting and be equally diagnostic. 
• Up to 6 images may be included with microscopic questions and are encouraged for 

immunohistochemistry. The question should still be coded as microscopic, not image. 
• Slides with plastic coverslips will not be accepted. If you only have access to plastic covered 

slides, you may submit the amount requested for the TDAC to review in plastic, and then the 
blocks for the ABPath to have the remainder cut, or uncovered slides and we will have the glass 
put on. 

• The ABPath will reimburse up to $7.00 per glass slide for each accepted case, after you submit 
the remaining slides and an invoice. You may submit the total needed initially, if that is easier 
for you, but there is the risk that the case may not be accepted by the committee.  Liquid based 
cytology slides (both cervical and non-gyn) will be reimbursed at a reasonable rate up to $15 per 
glass slide when liquid preparations are made specifically for ABPath use and an invoice is 
provided. 

• Sets of the submitted slides will be sent to each member of the TDAC, along with the book of 
questions for review prior to the meeting. 
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Figures 

 
On some of the practical examinations, figures or illustrations are used. These may be karyotypes, 
diagrams, graphs, maps, charts, or any appropriate image. Figures should be submitted online with the 
question. 
 
Electron Micrographs 
 
Electron micrographs may be submitted as high resolution digitized images. They are used in the 
anatomic pathology written division and in some of the subspecialty examinations. 
 
Virtual Microscopy 
 
Virtual microscopy (VM) is best used for small biopsies for which it would be very difficult to get the 
number of identical glass slides required for the TDAC. The VM slides should have sufficient numbers of 
diagnostic groups/cells, and keep in mind that thick areas that require focusing are harder to 
scan/visualize. Submitting two glass slides of each case is optimal, but one slide is acceptable in cases 
like frozen sections. You do not have to submit a slide for each TDAC member as we will review and 
project the slides at the meeting. Accepted slides will not be returned.  

• Take all dots/marks off of the slide, and try to use a piece of tissue that is no larger than 1 cm x 1 cm. 
• If larger than 1 cm x 1 cm, make a photocopy of the slide at 200% enlargement, and mark on the 

paper which area should be annotated, if appropriate. 
• Mark the smallest area possible, and do not mark the glass slide, just the paper enlargement. 

 
Additional Virtual Microscopy Information for Cytopathology 
 
Cytospins often don’t need to be marked, as the area is small enough. For ThinPreps, we often scan 
about 50-75% of the area, and any smears need to have appropriate areas marked on the photocopy. 
Do not submit SurePath slides. GYN cytology slides may be dotted. 
 
Category Codes 
 
Check the TDAC web page http://abpath.org/index.php/tdac-landing for a PDF document of the 
category codes. You will be able to print it out, or search for key words to help you in coding your 
questions. To search for a key word, open the document, click on edit-find (Ctrl+F), type in the word(s) 
to search for, click on next.  
 
The computer will not save your question without a category code being chosen. Please note that 
there are options for a Primary Category Code Number and Secondary Category Code Number on the 
item submission site. The primary code should be the most granular/specific, single best diagnosis (not a 
main heading or the technique used, e.g. flow cytometry, special stains, IHC, FISH, etc.). A secondary 
code is not necessary or desirable, but if the question could fit into two specific areas, you may add one 
or more secondary codes, but it should not be the specimen (e.g. blood smear, FNA, cytospin, etc.). 
Please be thoughtful in your selection(s). 
  

http://abpath.org/index.php/tdac-landing
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Instructions for Entering Questions 
 
Login to the Data Harbor question entry site 
 
All TDAC questions and images are submitted online. When the assignment for your TDAC meeting was 
sent to you, you also received two emails from Clarita Scioscia with the heading “entering ABPath 
questions”. In them you received your username and password to access the ABPath item submission 
site: https://secure.dataharborsolutions.com/abpath/dsp_login.aspx for entering your questions.  
 

1. Each time that you go to the item submission site listed above, you will enter your username 
and password in the provided blanks, hit “login”, and a new screen will pop up asking for a 
security code.  

2. Each time that you do this a new security code will be generated and sent to your email address.  
The subject line of the email should be “American Board of Pathology - Item Manager”. You will 
have to copy and paste it into the security code blank and will then gain access to the item 
submission site. 

3. There will be a dropdown box of TDAC names. Click on your TDAC and a screen with a header 
bar and a thumbnail listing of already submitted questions will appear.  

4. In the header bar you may choose to “Create a New Multiple Choice Question” or you may 
“Search”. 

5. If you would like to review the questions you have submitted, click on “Search”, scroll to the 
bottom of the screen and select your name from the dropdown “Author” field. Hit “Enter” and 
all of your questions will appear. 

 
Instructions for Uploading Images 
 
.jpg image(s) should be uploaded to the question submitted online. The question must first be saved 
before an image can be uploaded. You may submit up to six separate images, preferably not 
composites of multiple images in one. If you are submitting multiple images, perhaps with a gross, start 
with the gross and then progress from low power to higher. The maximum image size accepted is 5000 
pixels wide by 5000 pixels high or less, but no smaller than 1000 pixels wide by 563 pixels high. An easy 
way to resize images before uploading is to: 
 

1. Have your image up on the screen. 
2. Right click on it and open with “Paint” (or go to “open” and select Paint). 
3. Click on "resize". 
4. Change "percentage" to "pixels" by clicking on the button. 
5. Change whatever is the largest number (either horizontal or vertical) to 5000 and click OK.  

The other number will automatically change to the correct size. 
6. Save the file and exit. 

 
Trouble Replacing an Image 
 
If you are having trouble replacing an image, the issue is probably with the web browser settings. The 
“cookies” are remembering your old image. The easy fix would be to try a different browser, either 
Internet Explorer or Google Chrome, or follow these steps: 
 

1. Close Internet Explorer. 
2. Re-open Internet Explorer. 

  

https://secure.dataharborsolutions.com/abpath/dsp_login.aspx
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Trouble Replacing an Image - continued 
 

3. If you do not see the website toolbar near the upper left (File | Edit | View | Favorites | Tools | 
Help), click the “ALT” key on your keyboard, and the toolbar should then appear. 

4. In the toolbar click the Tools option, and then Internet Options. 
5. On the General tab of the pop-up window, beneath the “Browsing History” section: 

• Click the Settings button, and make sure “Every time I visit the webpage” is selected. Then 
click “Ok” to close. 

• Back on the first pop-up, beneath the “Browsing History” section, click on “Delete”. Make 
sure only the following checkboxes are selected: “Temporary Internet files and website 
files”, “Cookies and website data”, and “History”. 

6. Click on “Delete”. 
7. Once done, close the pop-up window, and try logging into the website again and try the image 

upload/deletion process again. 
 

Instructions for Screen Capture 
 
Prepare Your Screen  
 

1. Make sure the image on your screen is exactly as you would like it to appear. 
2. Make sure the image fills your screen, so you have the highest resolution possible. 
3. In Word, use View>Read Mode and adjust the zoom so the image fills the screen. 
4. In Excel or PowerPoint, adjust the zoom so the image fills the screen. 

 
You can use either Paint or the Snipping Tool to capture an image. If you don’t already use Snipping Tool 
or Paint, you may want to pin them to your task bar, so they are readily accessible. 
 
How to Pin Tools to your Taskbar 

Paint 
1. Click the Start button.  
2. In the Search field, replace Search programs and files with Paint. Paint will appear in the 

Search Results. 
3. Right click on Paint and click “Pin to Taskbar”.  

 
Snipping Tool 

1. Click the Start button. 
2. In the Search field, replace Search programs and files with Snip. Snipping Tool will appear in 

the Search Results. 
3. Right click on Snipping Tool and click “Pin to Taskbar”. 

 
Screen capture on a PC using Paint 

1. With your complete image on the screen, press the “Print Screen” key on your keyboard to copy 
the screen image into memory. Some keyboards may shorten this to “Prnt Scrn” or “PrntScr.” 
Additionally, some laptop computers may have “Print Screen” sharing a key with another 
function, meaning that you must hold down the “Fn” key to use the “Print Screen” function.  

2. Open Paint (usually found in the “Accessories” folder) and click “Paste” or press “Ctrl + V”.  
3. You may need to do some editing to eliminate parts of the image that were captured but not 

needed. Please see below or refer to “Help” in Paint or go to http://windows.microsoft.com/en-
us/windows/using-paint#1TC=windows-7. 

4. Click “Save As”, save as type “.jpg”, and select where you want to save the image and give it an 
appropriate filename.  
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Screen capture on a PC using Snipping Tool 
 

1. With the image on the screen, open Snipping Tool.  
2. Your screen will change to grey, indicating Snipping Tool is active.  
3. Drag the cursor around the area you want to capture.  
4. On the Snipping Tool toolbar, click the Copy icon.  

 
Screen capture on a MAC 
 
Press the Apple key + Shift + 3 all at the same time. You will find a capture of the screen on your desktop 
named “Picture”. 
 
Adding an Arrow to an Image 
 

1. Open the image in Paint. 
2. Select the arrow icon you want to use. 
3. In the image, left click and hold the mouse to place and adjust the arrow size. 
4. Let go of the mouse and click outside of the arrow box, somewhere in the image. 
5. Click on the “Save” icon. 

 
Adding a Text Box to an Image – for Magnification and/or Special Stains 
 

1. Open the image in Paint. 
2. Click on the “A” icon (A = text). 
3. Place the box in the lower left-hand corner of the image, unless it will obscure something 

important. The box can be moved as long as it has the “dotted” edge. 
4. Select Calibri as the typeface. 
5. The size should be around 36. 
6. Type in the magnification/special stain/etc. 
7. Select white as the “Second Color”. 
8. Click on “Opaque”. 
9. Click on box edge arrows to shrink edges to accommodate text. 
10. Click out of the text box somewhere in the image. 
11. Click on the “Save” icon. 

 
Select Tool  
 
Use the “Select” tool to select part of an image that you want to change.  

1. Open the image in Paint. 
2. On the Home tab, in the Image group, click the down arrow under “Select”. 
3. Do one of the following:  
• To select any square or rectangular part of the picture, click Rectangular selection, and then 

drag the pointer to select the part of the picture you want to work with.  
• To select any irregularly shaped part of the picture, click Free-form selection, and then drag the 

pointer to select the part of the picture you want to work with.  
• To select the whole picture, click Select all.  
• To select everything in the picture except for the currently selected area, click Invert selection.  
• To delete the selected object, click Delete.  
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Crop  
 
Use the “Crop” tool to crop an image, so only the part you select appears. 

1. Open the image in Paint. 
2.  On the Home tab, in the Image group, click the arrow under Select, and then click the kind of 

selection you want to make. 
3.  Drag the pointer to select the part of the image you want to save. 
4.  In the Image group, click “Crop” and everything outside of your selected area will disappear. 
5.  To save the cropped image as a new file, point to “Save as”, and then click the file type for the 

current image. Saving the cropped image as a new image file prevents overwriting the original 
image file. 

6.  In the File name box, type a new file name, and then click Save.  
 
If you will be creating a figure, graph, etc., we have created “Instructions to Create a .jpg from an Image 
Screen Capture from programs that do not allow you to save a .jpg image.” This is available on the TDAC 
webpage http://abpath.org/index.php/tdac-landing. We are limited because our exam center and 
remote testing site software requires that all images be in .jpg format. If you are unable to convert an 
image into a .jpg, you may email the image separately to clarita@abpath.org, not attached to the 
question but with the corresponding question number, and it will be converted into .jpg format. 
 
 
 
 
An example of the new question template is on the next few pages, along with explanation for each box. 
  

http://abpath.org/index.php/tdac-landing
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Visual Aid Codes: 
 

• Cell panel = used for blood banking 
• EM/Figure = any electron micrograph or line-type image or graph 
• Image = any photographic image, including images of microscopic fields 
• Micro + Virtual = same question, glass slides can be used on micro or virtual exam 
• Micro + VM + Image = same question, glass slides can be used on micro or virtual exam and image 
• Micro Glass Slide = microscopic glass slides submitted with question 
• Slide + Image = microscopic glass slide and JPG image 
• Table = any table that is not part of the question stem 
• Virtual = micro glass slide to be scanned as virtual (submit 2 slides) 
• Virtual + Image = virtual micro glass slide and JPG image 
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Questions entered into the online ABPath Item Bank should include all the fields required by the system. 
 
Stem - required 
The stem of the question is entered in the first box. Icons are available for special emphasis (bold, italics, 
underline), superscript, subscript, insertion of table templates, find (search function), help, spell check, 
and special characters’ table.  
 
Distractors - required 
Distractors A through E are available. Each has icons for special emphasis, super and subscripts, special 
characters’ table, and spell check. The correct answer is indicated by a radio button (circle) next to the 
letter of the distractor. Three (e.g., low, medium, high) to five answer choices are acceptable. 
 
Comments 
Any explanatory comments concerning the question should be entered here. Comments are not required. 
 
References - required 
One reference must be included for every question. Acceptable references are ISBN numbers of textbooks 
(page numbers not required), PubMed ID, DOI, or NLM numbers for articles, and http links for reliable 
websites. 
 
Feedback/Diagnosis - required 
Include on all questions, including written, to allow for easier question retrieval and detection of 
duplicate questions on exams. It is information we would give to someone who got the question wrong. 
It should be the key words or concept the candidate would need to review to get the question right. It 
could be the diagnosis, category, or sometimes just a concept. It’s not necessarily the answer (for 
instance if you have a list of age ranges), but what knowledge the question is testing. 
 
Anatomic Site 
Include for image, microscopic, and VM questions. 
 
Visual Aid Code 
If applicable, select from Cell Panel, EM/Figure, Image, Micro + Virtual, Micro + VM + Image, Micro Glass 
Slide, Slide + Image, Table, Virtual, Virtual + Image. 
 
Submitter/Block Acc. # 
For microscopic slides, indicate the case and block number for tissue submitted. 
 
Meeting Date 
Indicate only the year of the meeting in which the question is submitted. 
 
Sub Exam Type- required 
Select from Microscopic Glass Slides, Practical w/ or w/o Image, Virtual Microscopy, Written/Recall, or 
Microscopic and Virtual Microscopy. 
 
New Exam Type- required 
Select the examination cohort for which this question is suitable. The following choices are available: 
AP/CP, SubSpec, or International. Do not select International. 
 
Category Code Number- required 
Select the singular, most granular category code from those listed. For more information, see page 6. 
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Microscopic Slide ID – (only visible when “Micro Glass Slide” visual aid is selected) 
To be completed by ABPath staff if a question uses a slide that has already been accessioned with a 
different number. 
 
Microscopic Slide Count – (only visible when “Micro Glass Slide” visual aid is selected) 
To be completed by ABPath staff once all the microscopic slides are received. 
 
Incompatible Item 
To be completed by ABPath staff. 
 
Shares VA Item 
If multiple questions share the same visual aid (VA), either microscopic, virtual, or image, the accession 
number of the other questions(s) should be added here. 
 
Alphabetize Distractors 
When questions are edited, finalized, and moved to the permanent item bank by ABPath staff, the 
answers will automatically be alphabetized. If you do NOT want the answers in alphabetical order, e.g., a 
listing of diagnoses that go from benign to malignant, “uncheck” this box. 
 
TCR 
To be indicated by ABPath staff. 
 
Admin Review 
To be indicated by ABPath staff. 
 
Save- required 
This button must be clicked in order to save the question and image in the Item Bank. There is a “Save” 
button at the bottom and the top of the screen. If required fields are missing information, a red alert will 
pop up at the top of the screen indicating what information is missing and must be entered. If your 
question saves correctly, you will get a message that says “Your changes have been saved.” 
 
Copy Item 
If you want to copy a question, including the reference, category code, images, etc., after saving the 
original, click on this button. It will copy the question and have it open for you to edit. You would do 
this, for instance, if you were writing a second version of a question that uses the same images. You will 
then be able to edit and “Save” the new question that has been altered without having to upload the 
images a second time. 
 
Move Item 
This is used by ABPath staff to move a question that was not accepted by one test committee but 
referred to another for consideration. 
 
Copy to ABPath CertLink 
This is used by ABPath staff to copy a question where the author has included a “Critique” explaining 
why the correct answer is correct and each of the distractors is wrong. 
 
Delete 
To be used by ABPath staff. If you want to have one of your questions deleted, you should type “DELETE” 
in the stem box. 
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